
       GOSTEAM Hands-on Activity Template (Inquiry-based) 

 

Title: 

Ecological Risk Assessment and Satellite observations  

Short Description (Max 500 words): 

During this scenario, students will become familiar with the use of satellite data to characterize 
the spatiotemporal distribution of anthropogenic disturbances to the physical environment 
and the ecosystems. The scope is to address different geospatial concepts that are mainly laying 
on the concepts of pattern recognition, spatial clustering or dispersion and spatial dependency 
and autocorrelation. These terms might seem complex or difficult, however, they consist of 
some fundamental pillars of the Geo-related fields. 

Keywords (Up to 5):  

Land-Use changes, Ecological sensitivity, Spatial patterns 

 

Information about the Implementation 

Age and language of the students:             9-12           12-15          15-18           18+ 

Language:  Greek   Age: 

Number of Lessons – Duration (per lesson):  

Number of Lessons:              1   Duration per Lesson:             45’ 

Subjects: 

For which subject(s) the activity is usable, is it an interdisciplinary activity?  

Science 

 Physics         Chemistry         Biology         Geosciences         Environmental         Other 

Technology 

Engineering 

Arts 

Mathematics 
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Information about the Scenario 

Curriculum and country: 

Link of the current activity to the curriculum: 

Country:   Greece   Class:  Secondary  Grade:  7  - 10  

    

Topic:  Land-Use/Landcover changes,  

 Spatio-Temporal patterns 

  

Objectives (Max 100 words): 

Description of the learning objectives 

Some of the key objectives to be addressed through this activity include:  
 
1) The use of Geographic Information Systems to perform simplified spatio-temporal patterns 

recognition and assessment linked to landcover changes,  

2) To explain these changes in terms of the measured impacts on the Earth ecosystems and 

overall, the natural environment. 

 
 

Materials (Max 100 words): 

Which resources and materials (software, hardware) are needed?  

  Material: Search Engines, Satellite Images 

  Software: QGIS  

 

Spatial concepts, skills, and abilities: 

Which spatial concepts and skills are covered by the activity? 

Spatial concepts:  

Primitives: Identity/Name                Location       Space/Time 

Simple:     Distance Direction              Connectivity            Movement 

 Boundary         Shape/Area                  Adjacency 

Difficult:   Overlay  Buffer             Topology               Coordinate   

Map           Scale       Shortest Path Navigation 

Surface               Slope/Gradient            Aspect             Contour  

Complex: Interpolation     Map Projection                   Spatial Dependency   

Other: 
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Spatial skills: 

Map literacy 

Navigation/orientation 

Estimating distances and directions 

Recognizing and understanding patterns/Understand and identify models of 

spatial organization 

Select an ideal location based on the given spatial features 

Visualization 

Understand and identify spatial correlations/ dependencies 

Categorize spatial entities/ geographic features and identify hierarchies 

Compare spatial entities and draw analogies among them 

Identify/determine connections/relations 

Understanding scale in space and time 

Delineation of spatial regions/ zones based on given features/ properties 

Short Description 

Navigation/orientation: Finding one’s way in unfamiliar environments, interpreting and 
giving walking and driving directions.  
Estimating distances and directions: Measure paths, weighted distances, angles. 
Map literacy: Using, interpreting/understanding, learning from, and communicating 
acquired spatial knowledge from maps, comprehension of geographic features 
represented as points, lines, or polygons. 
Recognizing and understanding patterns/Understand and identify models of spatial 
organization. Delineation of spatial regions/zones based on given features/properties: 
Regionalization processes, pattern recognition and clustering identification in the 2d 
and/or the 3d world. 
Select an ideal location based on the given spatial features: Single or multi-criteria siting 
and optimal areas identification. 
Visualization: Visualizing spatial entities from written/oral verbal descriptions, from 
their 2d or graphical representations or through mental transformations; such as axis 
rotation or perspective taking. 
Understand and identify spatial correlations/ dependencies: The ability to realize, 
identify and explain patterns, clusters and relevant spatial dependencies. 
Categorize spatial entities/geographic features and identify hierarchies: Identify the 
hierarchical form of data and gradients between spatial entities. 
Compare spatial entities and draw analogies among them: Calculate and compare 
different geometric objects’ shapes, area and boundaries. 
Identify/determine connections/relations: The ability to identify links and common 
characteristics among spatial entities and between humans and spatial entities. 
Understanding scale in space and time: The understanding of changes/transitions 
through space and time for different spatio-temporal scales. 

 

Geospatial concepts and spatial abilities documentation (see Section 3.2): 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf 

http://www.gosteam.eu/wp-content/uploads/2021/05/GOSTEAM_IO1_A1_final.pdf
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Description of the activity in detail 

Question Eliciting Activities 

Provoke curiosity 

Describe ways and materials that teachers will present to their students to attract their 

attention to the topic investigated.  

 Usually, the most effective way to provoke students’ curiosity is by presenting an exciting 

video or a series of photos 

You can start the activity by asking students: 

How much does the broader area around your school has changed the last 30 years? 

Or maybe your city boundaries? 

How do you think these changes affect the natural environment and our lives? 

Explanatory videos for landcover changes monitoring: 

https://www.youtube.com/watch?v=-5BTOCZY8qg (Climate variables: Landcover) 

https://www.youtube.com/watch?v=957LUMNrzmg (Spotting changes) 

 

Propose preliminary explanations or hypotheses 

Formulate the scientifically oriented questions that teachers will present to the students to 

trigger their engagement in thinking about the topic investigated based on their existing 

knowledge. Make these questions digitally available and easily usable, e.g., by integrating them 

in the materials described in the previous step. 

 It is best to ask these questions in the context of a relative discussion.  

Can you imagine how can we quantify and evaluate these changes?  

What data we need? 

 

Active Investigation 

Plan and conduct simple investigation 

Provide the teachers with a specific plan of the investigation that will take place. Offer 

instructions about the activities they students will need to perform and what kind of materials 

they may need. Describe ways that the teachers can use to facilitate the students to focus on 

evidence.  

https://www.youtube.com/watch?v=-5BTOCZY8qg
https://www.youtube.com/watch?v=957LUMNrzmg
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This is the phase in which students are being prepared for the subsequent phase of 

evidence gathering during observation. 

During this step, students may collect evidence regarding the data they need, where 

to find these data and how they can “translate” these data to valuable spatial 

information.  

What is the difference between land-use and land cover change: 

https://www.sciencedirect.com/topics/earth-and-planetary-sciences/land-cover-
change 
https://oceanservice.noaa.gov/facts/lclu.html 
 
Land-use and land cover change definition, impact and trends: 
https://nca2014.globalchange.gov/report/sectors/land-use-and-land-cover-change 
 

The first step is to understand how we monitor these changes! 

Land cover datasets are typically based on observations from satellite-mounted 
sensors. These sensors record the intensity of reflectance of different wavelengths of 
the electromagnetic spectrum from the surface of the Earth. The raw data are then 
processed into analysis ready intermediate datasets. 

(Source: OECD-Monitoring Landcover changes) 

How are these changes categorized? 

Single changes or multiple changes events: 

 

What does it mean? For one specific area we can simply have a transition of the 
landcover from forest area to burnt area/bare ground (single change) or a multiple 
change event if on this area additional changes occurred (i.e. urban expansion etc.) 

 

Figure 1: Global extent of single and multiple land-use/cover changes 

https://www.sciencedirect.com/topics/earth-and-planetary-sciences/land-cover-change
https://www.sciencedirect.com/topics/earth-and-planetary-sciences/land-cover-change
https://oceanservice.noaa.gov/facts/lclu.html
https://nca2014.globalchange.gov/report/sectors/land-use-and-land-cover-change
https://www.oecd.org/env/indicators-modelling-outlooks/brochure-land-cover-change.pdf
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Changes that are focusing on specific landcover types, for example, forests, cropland 
and pastures or urban areas! 

For example, Figure 2 presents all forest areas globally and potential loss or gain of 
forest areas from 1960-2019. 

 

Similarly, Figure 3 presents all pasture/rangeland areas globally and potential loss or 
gain of this land-use type from 1960-2019. 

Observing these Figures (2 and 3), can you identify any specific patterns and trends? 

Can you explain these trend, potential causes etc.? 

Figure 2: Global forest areas (green: stable, red: loss, blue: gain, purple: gain & loss) 
Source: https://www.nature.com/articles/s41467-021-22702-2.pdf 

Figure 3: Global pasture/rangeland areas (yellow: stable, red: loss, blue: gain, purple: gain & loss) 
Source: https://www.nature.com/articles/s41467-021-22702-2.pdf 

 

https://www.nature.com/articles/s41467-021-22702-2.pdf
https://www.nature.com/articles/s41467-021-22702-2.pdf
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Furthermore, we are discussing about loss and gain of specific landcover types. How do 

we know about these changes?  

Keep always in mind that we are analyzing satellite images! And this is “translated” to 

pixels’ values! 

Explanation about raster data and satellite images: 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-
is-raster-data.htm 

 

 

 

 

 

 

 

 

How do we manage and process this type of data? 

Using Geographic Information Systems (GIS) and specific GIS-based applications and 

platforms! 

GIS definitions: https://www.esri.com/en-us/what-is-gis/overview 

GIS software and platforms (see QGIS): 
https://en.wikipedia.org/wiki/List_of_geographic_information_systems_software 

 

Finally, why do we monitor landcover changes and what is the impact on the natural 

environment and ecosystems? 

Land cover change is the best measure available to monitor pressures on terrestrial 
ecosystems and biodiversity. These changes generally occur slowly, but they are 
associated with declines in species diversity and populations and can have a major 
impact on ecosystems and climate (see Figure 5). 

 

 

Figure 4: Indicative example of a raster dataset (i.e satellite image) expressed as a grid of multiple 
cells with different (or the same) pixel/cell values, for example, landcover types 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-is-raster-data.htm
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/what-is-raster-data.htm
https://www.esri.com/en-us/what-is-gis/overview
https://en.wikipedia.org/wiki/List_of_geographic_information_systems_software
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Creation 

Gather evidence from observation 

Students can work in groups of two where each member of the group is responsible 

for:  

1) Data collection (maps, spatial data etc.) and reporting 

2) Data interpretation and analysis 

 

Before we begin, students have to download and install QGIS platform! 

QGIS Platform Download (version 3.18.1) 

https://qgis.org/downloads/ 

Download landcover data (CORINE 1990 and 2018) 

Figure 5: A schematic illustration of the climate impacts of land use and land cover change 
Source: https://www.researchgate.net/figure/A-schematic-illustration-of-the-climate-impacts-of-land-use-and-

land-cover-change-See_fig4_307841349 

https://qgis.org/downloads/
https://www.researchgate.net/figure/A-schematic-illustration-of-the-climate-impacts-of-land-use-and-land-cover-change-See_fig4_307841349
https://www.researchgate.net/figure/A-schematic-illustration-of-the-climate-impacts-of-land-use-and-land-cover-change-See_fig4_307841349
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The selected resource (e.g., a simulation, an experiment, an animation, a graph, or other exhibit 

of similar nature) must provide students with an opportunity to collect evidence addressing the 

scientific questions presented in previous stages through direct or indirect observation.  

It is recommended to introduce group work at this stage. Guide the teachers to divide 

students in groups, each of which will be facilitated by the teacher to formulate and to evaluate 

explanations to the scientific questions based on the collected evidence.  

Preparative steps 

1. Download CORINE data 

Visit the following website and Register (top right corner) 

https://land.copernicus.eu/pan-european/corine-land-cover 

 

After you finish your registration, by activating your account you can download any 

Corine dataset you want! 

When you click on a specific Corine dataset, you can visually inspect the data as also, 

you can download the Corine data (in .tif format) and load them on QGIS for further 

processing. 

You can also zoom-in to your data and inspect the color differences based on the 

different landcover types (see Figure 7)! But how these colors are translated??? 

Click on the legend button and see the different colorized landcover categories! 

https://land.copernicus.eu/pan-european/corine-land-cover 
 

Figure 6: Copernicus hub webpage for Corine landcover data 
 

https://land.copernicus.eu/pan-european/corine-land-cover
https://land.copernicus.eu/pan-european/corine-land-cover


GOSTEAM Hands-on Activity Template 

 

 

 

Figure 8: Corine data visualization and download button 
 

Figure 7: Map view (zoom-in) of the Corine 2018 to the broader Attica region 
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2. Download and install QGIS 3.18.1 version: https://qgis.org/downloads/ 

 Some technical guidelines considering the tools (QGIS Platform) we will use during this 

Activity! 

Load data: In general, data can be loaded in four ways. The first way (Figure 5-selection 2) is to 

use the Layer > Add Layer menu and select the appropriate type of data you wish to load. The 

second way (Figure 5-selection 1) is to open the Browser panel, navigate to the data you wish 

to load, and then drag the data on to the map display, or on to the Layers panel. The third way 

(Figure 5-selection 6) to load data is to enable the Manage Layers toolbar and click on the 

button representing the data type you wish to load. The fourth way is to locate the data in QGIS 

Browser, drag to the data, and drop it onto the QGIS Desktop Map Display or Layers panel 

(Source: https://www.gislounge.com/loading-data-mastering-qgis/). 

QGIS Interface 

 

Step 1 - Based on the above-mentioned instruction you can start with:   

1. During the first step of the Activity, un-compress the Corine compressed file and load Corine 

1990 and 2018 data in the QGIS platform (DATA Folder > U2018_CLC2018_V2020_20u1.tif 

and U2000_CLC1990_V2020_20u1.tif files). 

2. Use the Main toolbar (top of the screen) -> Layers -> Raster Layer -> Navigate to your folder 

and load U2018_CLC2018_V2020_20u1.tif and U2000_CLC1990_V2020_20u1.tif files. 

3. Change layout colors using the instructions on the Document folder (How use ESRI CLC 

raster files in QGIS).  

Figure 9: QGIS interface and key functionalities 

https://qgis.org/downloads/
https://www.gislounge.com/loading-data-mastering-qgis/
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4. Zoom in to the area of your interest (See Figure 10) 

 

 

After you zoom-in to a specific area (e.g. Attica region in Greece), you have to clip your 

files (Corine 1990 and 2018) to this specific extent (we clip our data in order to have a 

better visual inspection of the landcover changes as also, to reduce the computational 

effort needed due to the files’ size!). 

For clipping our data, we need a specific raster clipping tool. On the main toolbar on 

the top of QGIS platform use Raster > Extraction > Clip Raster by Extent.  

Follow the Steps described in Figure 11! 

 

Figure 10: Load Corine data and change Symbology colors 

2. Load Corine 1990 and 

2018 data 

1. Change colors using the instructions of the data Document folder (How 

use ESRI CLC raster files in QGIS) 
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Important note: “Clip Raster by Extent” means to clip our image (raster) to the 
boundaries that are visible on our screen when we zoomed-in to our area of interest! 

 

 

After you clip your data follow the instructions on the Document folder (How use ESRI 

CLC raster files in QGIS) in order to adjust the colors of your clipped image. See Figure 

12!  

Overlay the Corine 1990 and Corine 2018 images. Do you see any differences???? 

 

 

1. Load Corine 2018 data 

as Input layer 

2. Use Map Canvas Extent 

as Clipping Extent 

3. Save your file to your folder as 

Corine_2018_clip 

4. REPEAT THIS PROCESS FOR 

CORINE 1990! 

Figure 11: Clip your Corine 1990 and 2018 data to a specific area of interest 
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BUT HOW WE QUANTIFY THE DIFFERENCES AND THE TRANSITION FROM ONE 
LAND-USE TYPE TO ANOTHER??? 

We have to simply compare each pixel’s value from Corine 1990 and 2018 and we have 

to do this for all pixels! To succeed that, we need a specific tool called “Raster 

Calculator”.  Using this tools we can run through different math operations and 

conditional statements between different rasters (images). 

A simplified measure to compare pixels’ values is by subtracting the pixel values of 

Corine 1990 from Corine 2018!  

Hence, open Raster Calculator via the main toolbar > Raster > Raster Calculator and 
type: 

Figure 12: Clipped Corine image to a specific region extent, grey scale colors (left) and colorized 
(right) 

2018 --- 1990 

 

Click on the Layers panel on 
overlay one image on another 

Figure 12: Corine differences between 1990 (right image) and 2018 (left Image) 
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"Corine_1990_clip@1" - "Corine_2018_clip@1" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

1. Type the expression 

2. Save layer to your folder as Final.tif 

Figure 13: Raster calculator tool for Images processing  

Figure 14: Final results in grey scale (left) and colorized (right)  
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In order to change the Final.tif colors you can double-click on the Image name on the 

Layers panel > Symbology > Render type: Singleband Pseudocolor > Classify > OK 

(Figure 15). 

 

 

Inspect your results, the colors and the min-max values! 

 

Discussion 

Explanation based on evidence 

Encourage your students to provide correct explanations for the topic(s) investigated.  

Describe ways and they can use to this end and give them directions how to discover them. 

You can start a conversation related to the results explanation by asking: 

What do you think that the minimum and maximum values indicate? 

Increased minimum values point out a potential landcover transition from urban 

areas to forest areas or water surfaces! 

On the contrary, increased positive values highlight transition patterns from forest 

areas or water surfaces to urban areas! 

1. Double-click 

2. Symbology 

3. Select Singleband Pseudocolor 

4. Press Classify 

5. Optionally, you can change 
coloramp 

Figure 15: Change colors on your resulted Image  
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Ask students if they can identify the broader area that their home is located! What 

changes do they see? Can they remember any specific examples of green areas near 

their homes that changed to urban areas? 

 

Consider other explanations 

Direct teachers to facilitate the student groups to evaluate their own explanations in the light 

of alternative explanations, particularly those reflecting scientific understanding. Illustrate 

examples they can use and give them instructions how to locate them.  

On the area they studied how the ecosystems are affected and what measures do 

they propose to protect them?  

Source: https://medium.com/age-of-awareness/making-the-most-of-the-un-decade-on-ecosystems-

restoration-bioregional-regenerative-development-484119e763ee 

Support material (Table 2 and 4):  

https://onlinelibrary.wiley.com/doi/full/10.1111/rec.13035 

Support material - Sparing or sharing: 

https://community.rspb.org.uk/ourwork/b/science/posts/sparing-or-

sharing?CommentId=7df3451c-3880-4025-bec8-9a8424e158a1 

Finally, you can ask students “What if we want to monitor landcover changes 

before 1990? What could we do and is it possible?” 

https://medium.com/age-of-awareness/making-the-most-of-the-un-decade-on-ecosystems-restoration-bioregional-regenerative-development-484119e763ee
https://medium.com/age-of-awareness/making-the-most-of-the-un-decade-on-ecosystems-restoration-bioregional-regenerative-development-484119e763ee
https://onlinelibrary.wiley.com/doi/full/10.1111/rec.13035
https://community.rspb.org.uk/ourwork/b/science/posts/sparing-or-sharing?CommentId=7df3451c-3880-4025-bec8-9a8424e158a1
https://community.rspb.org.uk/ourwork/b/science/posts/sparing-or-sharing?CommentId=7df3451c-3880-4025-bec8-9a8424e158a1
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The answer is that yes, we can! But, it is a difficult task because we have to search 

for satellite images that are not processed at all! Hence, we do not know about the 

landcover types, only band combinations of the satellites’ sensors wave spectrums. 

This means that we have to process these images in order to extract landcover 

types and remember, for a limited spatial coverage (and not the entire Europe)! 

Reflection 

Communicate explanation 

Guide teachers to facilitate each student group to reflect on the previous experiences and to 

produce a report with its findings, presenting and justifying the proposed explanations to the 

other groups and the teacher. 

Provide content which the teacher can use to help the students to get familiarized and to 

become efficient in scientific writing. 

Ask from students to write a short report by incorporating the scope of this Activity 

(the objective?), the data and the tools they used, what methodology (QGIS tools) 

and to present their results in the form of maps (images) by reporting the differences 

on the landcover types from 1990 to 2018. 

They can also report all potential adjustments they made (clipping areas) or any 

future research they want to consider (add landcover data for year 2000, 2011 etc.). 

The report outline could be in the form of:  
 

i) Introduction,  

ii) Relevant information about monitoring landcover changes and how they 

affect the ecosystems,  

iii) Study area and Data used,  

iv) Methodology,  

v) Results and Discussion and finally,  

vi) Conclusions and Future work 

 

Follow-up activities and materials 

Describe and direct the user to any follow-up activities or materials that can be used to wrap-

up the hands-on activity.  

These could include appropriate learning assessment and/or reminder materials (e.g.,  

quizzes, games, other user-friendly tests), hints for further activities etc. 

Land-use and water management game: 
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https://games.bwdh2o.org/home/selectyourgames 

Earth observation Poster: 

https://ckan.ssec.wisc.edu/dataset/2016-earth-observation-day-poster 

EO Browser Change detection examples: 

https://apps.sentinel-hub.com/eo-

browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-

MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-

hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-

b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-

11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-

NDVI  

(Select add to compare both images from different years and go to compare tab) 

 

Sustainable contact 

Loukas Katikas (lkatikas@ea.gr) 

 

References (if any): 

OECD (2018): Report on “Monitoring Landcover changes” 

Ward D. and Mahowald N. (2014): Potential climate forcing of land use and land cover 
change, Atmospheric Chemistry and Physics;14(8), DOI:10.5194/acpd-14-12167-2014 

Winkler et al. (2021): Global land use changes are four times greater than previously 

estimated, Nature Communications;12:2501, https://doi.org/10.1038/s41467-021-

22702-2 

ESRI Overview: What is GIS 

Assessment (if any): 

 

https://games.bwdh2o.org/home/selectyourgames
https://ckan.ssec.wisc.edu/dataset/2016-earth-observation-day-poster
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
https://apps.sentinel-hub.com/eo-browser/?zoom=10&lat=30.6338&lng=30.2879&themeId=HISTORICAL-NORMAL-MODE&visualizationUrl=https%3A%2F%2Fservices.sentinel-hub.com%2Fogc%2Fwms%2Fa2b6e4cb-6aa9-4a6e-a38f-b24ea4e2a1f4&datasetId=AWS_LOTL1&fromTime=2019-08-11T00%3A00%3A00.000Z&toTime=2019-08-11T23%3A59%3A59.999Z&layerId=4-NDVI%20
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